MULTIMEDIA APPLICATIONS

1 INTRODUCTION TO MULTIMEDIA

Multimedia has become an inevitable part of any presentation. It has found a variety of applications right from
entertainment to education. The evolution of internet has also increased the demand for multimedia content.

1.1. Definition

Multimedia is the media that uses multiple forms of information content andinformation processing (e.g. text,
audio, graphics, animation, and video, interactivity) toinform or entertain the user. Multimedia also refers to the
use of electronic media to storeand experience multimedia content. Multimedia is similar to traditional mixed
media infine art, but with a broader scope. The term “rich media” is synonymous for interactivemultimedia.

1.2. History of Multimedia Systems

Newspaper were perhaps the first mass communication medium to employ Multimedia -- they used mostly text,
graphics, and images.

In 1895, Gugliemo Marconi sent his first wireless radio transmission at Pontecchio, Italy. A few years later (in
1901) he detected radio waves beamed across the Atlantic. Initially invented for telegraph, radio is now a major
medium for audio broadcasting.

Television was the new media for the 20th century. It brings the video and has since changed the world of mass
communications.

Some of the important events in relation to Multimedia in Computing include:

1945 - Bush wrote about Memex

1967 - Negroponte formed the Architecture Machine Group at MIT

1969 - Nelson & Van Dam hypertext editor at Brown

Birth of the Internet

1971 - Email

1976 - Architecture Machine Group proposal to DARPA: Multiple Media

1980 - Lippman & Mohl: Aspen Movie Map

1983 - Backer: Electronic Book

1985 - Negroponte, Wiesner: opened MIT Media Lab

1989 - Tim Berners-Lee proposed the World Wide Web to CERN (European Council for Nuclear Research)
1990 - K. Hooper Woolsey, Apple Multimedia Lab, 100 people, educ.

1991 - Apple Multimedia Lab: Visual Almanac, Classroom MM Kiosk

1992 - The first M-bone audio multicast on the Net

1993 - U. Illinois National Center for Supercomputing Applications: NCSA Mosaic
1994 - Jim Clark and Marc Andreesen: Netscape

1995 - JAVA for platform-independent application development. Duke is the first applet.

1996 - Microsoft, Internet Explorer.



1.3. Multimedia hardware and software-various classes

1.3.1 MULTIMEDIA HARDWARE REQUIREMENTS
1.3.1.1CPU

Central Processing Unit (CPU) is an essential part in any computer. It is considered as the brain of computer,
where processing and synchronization of all activities takes place. The efficiency of a computer is judged by the
speed of the CPU in processing of data. For a multimedia computer a Pentium processor is preferred because of
higher efficiency.

1.3.1.2 Monitor

The monitor is used to see the computer output. Generally, it displays 25 rows and 80 columns of text. The text
or graphics in a monitor is created as a result of an arrangement of tiny dots, called pixels. Resolution is the
amount of details the monitor can render. Resolution is defined in terms of horizontal and vertical pixel (picture
elements) displayed on the screen.

1.3.1.3 Video Grabbing Card

We need to convert the analog video signal to digital signal for processing in a computer. Normal computer will
not be able to do it alone. It requires special equipment called video grabbing card and software to this
conversion process. This card translates the analog signal it receives from conventional sources such as a VCR
or a video camera, and converts them into digital format.

1.3.1.4 Sound Card

Today’s computers are capable of creating the professional multimedia needs. Not only you can use computer
to compose your own music, but it can also be used for recognition of speech and synthesis. It can even read
back the entire document for you. But before all this happens, we need to convert the conventional sound signal
to computer understandable digital signals. This is done using a special component added to the system called
sound card.

1.3.1.5 CD-ROM

CD-ROM is a magnetic disk of 4.7 inches diameter and it can contain data up to 680 Megabytes. It has become
a standard by itself basically for its massive storage capacity, faster data transfer rate. To access CD-ROM a
very special d1rive is required and it is known as CD-ROM drive.

1.3.2 MULTIMEDIA SOFTWARE REQUIREMENTS

For the creation of multimedia on the PC there are hundreds of software packages that are available from
manufacturers all over the world.

These software packages can cost anything from being absolutely free (normally this software is called freeware
or shareware) to anything upwards of £500.

1.3.2.1 Adobe CS4

Adobe CS4 is a collection of graphic design, video editing, and web development applications made by Adobe
Systems many of which are the industry standard that includes

1.3.2.2 Adobe Dreamweaver

Although a hybrid WY SIWYG and code-based web design and development application,

Dreamweaver’s WYSIWYG mode can hide the HTML code details of pages from the user, making it possible
for non-coders to create web pages and sites. WYSIWYG (What You See Is What You Get) web development
software that allows users to create websites without using Html, everything can be done visually.

1.3.2.3 Adobe Fireworks



A graphics package that allows users to create bitmap and vector graphics editor with features such as: slices,
the ability to add hotspots etc.) For rapidly creating website prototypes and application interfaces.

1.3.2.4 Gimp
Is an alternative to Photoshop and cheaper but not quite as good.
1.3.2.5 Google Sketchup

SketchUp is a 3D modelling program designed for architects, civil engineers, filmmakers, game developers, and
related professions.

1.3.2.6 Microsoft FrontPage

As a WYSIWYG editor, FrontPage is designed to hide the details of pages’ HTML code from the user, making
it possible for novices to easily create web pages and sites.

1.3.2.7 Apple Quicktime

QuickTime is an extensible proprietary multimedia framework developed by Apple, capable of handling various
formats of digital video, 3D models, sound, text, animation, music, panoramic images, and interactivity.

1.3.2.8 Photoshop Pro

Adobe Photoshop, or simply Photoshop, is a graphics editing program developed and published by Adobe
Systems. It is the current market leader for commercial bitmap and image manipulation software, and is the
flagship product of Adobe Systems. It has been described as “an industry standard for graphics professionals”

1.3.2.9 Microsoft PowerPoint

PowerPoint Presentations are generally made up of slides may contain text, graphics, movies, and other objects,
which may be arranged freely on the slide.

1.3.2.10 Adobe Flash Player

Adobe Flash (formerly Macromedia Flash) is a multimedia platform that is popular for
adding animation and interactivity to web pages. Originally acquired by Macromedia, Flash was introduced
in 1996, and is currently developed and distributed by Adobe Systems.

Flash is commonly used to create animation, advertisements, and various web page Flash components, to
integrate video into web pages, and more recently, to develop rich Internet applications.

1.3.2.11 Adobe Shockwave

Adobe Shockwave (formerly Macromedia Shockwave) is a multimedia player program, first developed
by Macromedia, acquired by Adobe Systems in 2005. It allows Adobe Director Applications to be published on
the Internet and viewed in a web browser on any computer which has the Shockwave plug-in installed.



1.4. Components of a Multimedia System
Components (Hardware and Software) required for a multimedia system:
1. Capture devices

B Video Camera, Video Recorder, Audio Microphone, Keyboards, mice, graphics tablets, 3D
input devices, tactile sensors, VR devices. Digitising/Sampling Hardware

2. Storage Devices
B Hard disks, CD-ROMs, Jaz/Zip drives, DVD, etc
3. Communication Networks
B Ethernet, Token Ring, FDDI, ATM, Intranets, Internets.
4. Computer Systems
B Multimedia Desktop machines, Workstations, MPEG/VIDEO/DSP Hardware
5. Display Devices

B CD-quality speakers, HDTV, SVGA, Hi-Res monitors, Color printers etc.

1.5. Elements of Multimedia

Multimedia means that computer information can be represented through audio,
Graphics, image, video and animation in addition to traditional media (text and graphics).
Hypermedia can be considered as one type of particular multimedia application.

1.6. Categories of Multimedia

Multimedia may be broadly divided into linear and non-linear categories. Linearactive content progresses
without any navigation control for the viewer such as a cinemapresentation. Non-linear content offers user
interactivity to control progress as used witha computer game or used in self-paced computer based training.
Non-linear content isalso known as hypermedia content.

Multimedia presentations can be live or recorded. A recorded presentation mayallow interactivity via a
navigation system. A live multimedia presentation may allowinteractivity via interaction with the presenter or
performer.

1.7. Applications of Multimedia

Multimedia finds its application in various areas including, but not limited to,advertisements, art, education,
entertainment, engineering, medicine, mathematics,business, scientific research and spatial, temporal
applications.

A few application areas of multimedia are listed below:
1.7.1 Creative industries

Creative industries use multimedia for a variety of purposes ranging fromfine arts, to entertainment, to
commercial art, to journalism, to media and softwareservices provided for any of the industries listed below. An
individual multimediadesigner may cover the spectrum throughout their career. Request for their skillsrange
from technical, to analytical and to creative.

1.7.2 Commercial



Much of the electronic old and new media utilized by commercial artists isMultimedia. Exciting presentations
are used to grab and keep attention inadvertising. Industrial, business to business, and interoffice
communications areoften developed by creative services firms for advanced multimedia presentationsbeyond
simple slide shows to sell ideas or liven-up training. Commercial

Multimedia developers may be hired to design for governmental services and
Non-profit services applications as well.
1.7.3 Entertainment and Fine Arts

In addition, multimedia is heavily used in the entertainment industry,especially to develop special effects in
movies and animations. Multimedia gamesare a popular pastime and are software programs available either as
CD-ROMs oronline. Some video games also use multimedia features.Multimedia applications that allow users
to actively participate instead of justsitting by as passive recipients of information are called Interactive
Multimedia.

1.7.4 Education

In Education, multimedia is used to produce computer-based trainingcourses (popularly called CBTs) and
reference books like encyclopaedia andalmanacs. A CBT lets the user go through a series of presentations, text
about aparticular topic, and associated illustrations in various information formats.Edutainment is an informal
term used to describe combining education withentertainment, especially multimedia entertainment.

1.7.5 Engineering

Software engineers may use multimedia in Computer Simulations foranything from entertainment to training
such as military or industrial training.Multimedia for software interfaces are often done as collaboration
betweencreative professionals and software engineers.

1.7.6 Industry

In the Industrial sector, multimedia is used as a way to help presentinformation to shareholders, superiors and
coworkers. Multimedia is also helpfulfor providing employee training, advertising and selling products all over
theworld via virtually unlimited web-based technologies.

1.7.7 Mathematical and Scientific Research

In Mathematical and Scientific Research, multimedia is mainly used formodeling and simulation. For example,
a scientist can look at a molecular modelof a particular substance and manipulate it to arrive at a new
substance.Representative research can be found in journals such as the Journal ofMultimedia.

1.7.8 Medicine

In Medicine, doctors can get trained by looking at a virtual surgery or theycan simulate how the human body is
affected by diseases spread by viruses andbacteria and then develop techniques to prevent it.

1.7.9 Multimedia in Public Places

In hotels, railway stations, shopping malls, museums, and grocery stores,multimedia will become available at
stand-alone terminals or kiosks to provideinformation and help. Such installation reduce demand on traditional
informationbooths and personnel, add value, and they can work around the clock, even in themiddle of the
night, when live help is off duty.

A menu screen from a supermarket kiosk that provide services rangingfrom meal planning to coupons. Hotel
kiosk list nearby restaurant, maps of thecity, airline schedules, and provide guest services such as automated
checkout.Printers are often attached so users can walk away with a printed copy of theinformation. Museum
kiosk are not only used to guide patrons through theexhibits, but when installed at each exhibit, provide great
added depth, allowingvisitors to browser though richly detailed information specific to that display.

1.8. Different multimedia file formats



1.8.1 Common Video Formats

Format File  |Description
MPEG .mpg |MPEG. Developed by the Moving Pictures Expert Group. The first popular video
.mpeg [format on the web. Used to be supported by all browsers, but it is not supported in
HTMLD5 (See MP4).

AVI .avi AVI (Audio Video Interleave). Developed by Microsoft. Commonly used in video
cameras and TV hardware. Plays well on Windows computers, but not in web
browsers.

WMV wmv WMV (Windows Media Video). Developed by Microsoft. Commonly used in video
cameras and TV hardware. Plays well on Windows computers, but not in web
browsers.

QuickTime | .mov |QuickTime. Developed by Apple. Commonly used in video cameras and TV
hardware. Plays well on Apple computers, but not in web browsers. (See MP4)

RealVideo | .rm RealVideo. Developed by Real Media to allow video streaming with low

ram  |bandwidths. It is still used for online video and Internet TV, but does not play in
web browsers.

Flash swf  |Flash. Developed by Macromedia. Often requires an extra component (plug-in) to

flv play in web browsers.

Ogg .0gg |Theora Ogg. Developed by the Xiph.Org Foundation. Supported by HTMLJ5.

WebM .webm |WebM. Developed by the web giants, Mozilla, Opera, Adobe, and Google.
Supported by HTMLS5.

MPEG-4 .mp4  |MP4. Developed by the Moving Pictures Expert Group. Based on QuickTime.

or MP4 Commonly used in newer video cameras and TV hardware. Supported by all
HTMLS5 browsers. Recommended by YouTube.

1.8.2 Audio Formats

Format File |Description
MIDI .mid |MIDI (Musical Instrument Digital Interface). Main format for all electronic music
.midi |devices like synthesizers and PC sound cards. MIDI files do not contain sound, but
digital notes that can be played by electronics. Plays well on all computers and music
hardware, but not in web browsers.
RealAudio | .rm  |RealAudio. Developed by Real Media to allow streaming of audio with low
.ram |bandwidths. Does not play in web browsers.
WMA wma (WMA (Windows Media Audio). Developed by Microsoft. Commonly used in music
players. Plays well on Windows computers, but not in web browsers.
AAC .aac  |AAC (Advanced Audio Coding). Developed by Apple as the default format for

iTunes. Plays well on Apple computers, but not in web browsers.




WAV .wav |WAV. Developed by IBM and Microsoft. Plays well on Windows, Macintosh, and
Linux operating systems. Supported by HTML5.

Ogg .09 |Ogg. Developed by the Xiph.Org Foundation. Supported by HTML5.

MP3 .mp3 |MP3 files are actually the sound part of MPEG files. MP3 is the most popular format
for music players. Combines good compression (small files) with high quality.
Supported by all browsers.

MP4 .mp4 |MP4 is a video format, but can also be used for audio. MP4 video is the upcoming
video format on the internet. This leads to automatic support for MP4 audio by all
browsers.

1.8.3 Animation File Formats

Some file formats are designed specifically to contain animations and the can be ported among application and
platforms with the proper translators.
o Director *.dir, *.dcr
AnimationPro *.fli, *.flc
3D Studio Max *.max
SuperCard and Director *.pics
CompuServe *.gif
Flash *.fla, *.swf

Following is the list of few Software used for computerized animation:
e 3D Studio Max
e Flash
e AnimationPro

1.8.4 Image File Formats
e Format Extension
Microsoft Windows DIB .bmp .dib .rle
Microsoft Palette .pal
Autocad format 2D .dxf
JPEG .jpg
Windows Meta file .wmf
Portable network graphic .png
Compuserve gif .gif
Apple Macintosh .pict .pic .pct

Software used for creating images
e Coreldraw
e MSPaint
e Autocad

1.9. Advantages of Multimedia:

1.9.1 Increased learning effectiveness

1.9.2 Gains and holds attention

1.9.3 More appealing

1.9.4 Reduces training cost

195 Easytouse

1.9.6 Give information cost

1.9.7 Provides high quality of presentations
1.9.8 Multi-sensorial



1.9.9 Integrated and interactive
1.9.10 Can be used as a wide variety of audience

1.10. Disadvantages of Multimedia:
1.10.1 Expensive

1.10.2 Not always ready to configure
1.10.3 Requires special hardware
1.10.4 Not always compatible

1.10.5 Takes time to compile

1.10.6 Information overload

1.10.7 Misuse and/or overuse

1.10.8 Limitations of technology

2 Content and Project Planning, Designing and development
2.1. Project Planning

Project planning refers to everything you do to set up your project for success. It’s the process you go through
to establish the steps required to define your project objectives, clarify the scope of what needs to be done and
develop the task list to do it.

2.2. Planning steps

2.2.1 Mobilize quickly. When you use the right tools and templates, you don’t have to start from scratch.
2.2.2 Break down your deliverables and get input from your team on the tasks that are required.

2.2.3 Create a timeline which specifies the steps necessary to complete the work.

2.2.4 Look for resources, both people and equipment, tools and templates.

2.2.5 Use project management software to share and collaborate with your team.

2.3. Planning process

2.3.1 Defining the Goal: The Goal of a multimedia application is defined by the scope of work, which is a
written description of the proposed multimedia project. The scope of work clarifies your ideas and goals
regarding the proposed project. It also helps the development team members to visualize the basic
objectives of the programme.

2.3.2 Outlining: Once the goal and the objectives of the programme are clear, the next step is to create Outline
of the project. The outlining of Multimedia structure is translated into branches or points of decision on
the screen. Even the main outlining headings may become options available to the user in the main menu
of the Multimedia presentation program with sub-heading becoming the Sub-Menu entries.

2.3.3 Logic flow chart: The logic flow chart is an important component of an Interactive Multimedia
Programme. A logic flow chart is a graphical road map of the proposed application. The Authoring team
takes the help of this flowchart to produce the final multimedia Application.

2.3.4 Program storyboard: The storyboard is a graphical representation of the proposed multimedia project.
The storyboard is an extension of ideas presented in the programme script. It is presented with a series of
templates used for various purposes. These templates are very useful information and help the developer
to keep a production log or history of the work. They also help in keeping track of the production design
and help in identifying the design parameters for the application development.

2.3.5 Planning for creation of multimedia building blocks: The development of multimedia building blocks
is an extensive process and requires a number of production steps.

2.3.6 Copyright Issue and Its Management: While designing multimedia application, copyright issue plays a
crucial role because of two fundamental reasons.

2.3.7 Defining the Production Schedule: A Timeline, defining the activities needed the person responsible for
each activity and the start/end time of each activity should be developed.

2.3.8 Devising a Technical Plan: A technical plan defines how an end user will experience the project and
accordingly lays down the system requirement conditions like screen requirement, CD-ROM speed,
memory requirement and hard disk requirement.



2.3.9 Project Budgeting: Once the project timeline or schedule is ready, the next step is to prepare the project
budget. This is essential as time and money are not infinite resources.

2.3.10 Hardware Issues:. Hardware issues include deciding, securing the fastest CPU and RAM and
largest monitors that is affordable, sufficient disk storage for all working files and records, file sharing for
collaborative work via networks or e-mail and establishing a file back-up system.

2.3.11 Authoring Software Selection: Selection of appropriate authoring software depends on team expertise,
funds required to acquire new software and to train the manpower. Two most widely used authoring
applications today are Macromedia Director and Macromedia Authorware.

2.4. Data compression

Data compression is the process of modifying, encoding or converting the bits structure of data in such a way
that it consumes less space on disk. It enables reducing the storage size of one or more data instances or
elements. Data compression is also known as source coding or bit-rate reduction.

Two compression techniques are mostly used: Lossless and Lossy compression.
2.4.1 Lossless compression

A lossless compression algorithm eliminates only redundant information, so that one can recover the data
exactly upon decompression of the file.

Lossless data compression is compression without any loss of data quality. The decompressed file is an exact
replica of the original one.

2.4.1 Lossy compression

A lossy compression method is one where compressing data and then decompressing it retrieves data that may
well be different from the original, but is "close enough" to be useful in some way.The algorithm eliminates
irrelevant information as well, and permits only an approximate reconstruction of the original file. Lossy
compression is also done by re-writing the data in a more space efficient way

2.5. Text encoding

Encoding is the process of putting a sequence of characters (letters, numbers, punctuation, and certain
symbols) into a specialized format for efficient transmission or storage. ... Encoding and decoding are used in
data communications, networking, and storage.

Character encoding is the process of representing individual characters using a corresponding encoding system
made up of other symbols and types of data. Character coding is used for many different purposes.

Character encoding is also known as a character set or character map.

2.6. Audio encoding techniques

Audio compression and coding techniques are used to compress audio signals and can be based on sampling or
on signal processing of audio sequences.

Audio is the most important medium to be transmitted in a conference-like application. In order to be able to
successfully transmit audio through a low bandwidth network, however, one needs to compress it, so that its
required bandwidth is manageable.

2.7. Types of images

2.7.1 TIFF (also known as TIF), file types ending in .tif
TIFF stands for Tagged Image File Format. TIFF images create very large file sizes. TIFF images are
uncompressed and thus contain a lot of detailed image data (which is why the files are so big) TIFFs are
also extremely flexible in terms of color (they can be grayscale, or CMYK for print, or RGB for web)



and content (layers, image tags).TIFF is the most common file type used in photo software (such as
Photoshop).

2.7.2 JPEG (also known as JPG), file types ending in .jpg
JPEG stands for Joint Photographic Experts Group, which created this standard for this type of image
formatting. JPEG files are images that have been compressed to store a lot of information in a small-
size file. Most digital cameras store photos in JPEG format, because then you can take more photos on
one camera card than you can with other formats

2.7.3 GIF, file types ending in .gif
GIF stands for Graphic Interchange Format. This format compresses images but, as different from
JPEG, the compression is lossless (no detail is lost in the compression, but the file can’t be made as
small as a JPEG).GIFs also have an extremely limited color range suitable for the web but not for
printing. This format is never used for photography, because of the limited number of colors. GIFs can
also be used for animations.

2.7.4 PNG, file types ending in .png
PNG stands for Portable Network Graphics. It was created as an open format to replace GIF, because
the patent for GIF was owned by one company and nobody else wanted to pay licensing fees. It also
allows for a full range of color and better compression.
It’s used almost exclusively for web images, never for print images. For photographs, PNG is not as
good as JPEG, because it creates a larger file. But for images with some text, or line art, it’s better,
because the images look less “bitmappy.”

2.7.5 Raw image files
Raw image files contain data from a digital camera (usually). The files are called raw because they
haven’t been processed and therefore can’t be edited or printed yet.
When you snap a photo with your camera, it's saved immediately in a raw file format. Only when you
upload your media to a new device and edit it using image software is it saved using one of the image
extensions

2.8. Capturing images using camera/scanner,
An image scanner is able to scan and capture text, imagery and objects and then turn them into a digital
image, the most common scanners are flatbeds.
Digital Cameras like scanners are capable of image capture, except a digital camera is more
transportable making them the preferable choice

2.9. Coding techniques for Moving Images, Editing
Moving images are an illusion. When we view an animation or video we are viewing a series of still
pictures presented in rapid succession. The success of the illusion is dependent on the quality of the
individual images and the rate at which they are presented.

2.9.1. Animation
Animations are generally a series of 8-bit graphic images created in a graphics program. The images
can then be compiled into an animated GIF file or QuickTime movie file for use in multimedia
presentations and on the World Wide Web. Frame rates in animations will vary according to the
content.

2.9.2. Video
Video can be captured using a standard video recorder and then digitized using video digitizing
hardware within a multimedia computer. For video to be effective, the frame rate must be at least 10
frames per second and the bit depth of the individual frames must be 16 or greater. The dimensions of
the digitized video can be as small as 160 by 120 or as large as 640 by 480 pixels.

2.10. Editing of images



Image editing software has become ubiquitous in this digital age. Whether you’re creating a web

interface or simply cropping and enhancing your family photos.

Image editing tools are used to edit existing bitmap images and pictures.

You’ll need your favourite image editor to do it.

2.10.1. Adobe Photoshop

Adobe Photoshop is a cutting-edge image processing software package that enables you to create and
edit images on computers. One can manipulate one’s images with special effects and techniques.
Images can be imported and exported across programs in any format. These tools have been used to
edit and create images for motion pictures, animations and for artwork.

2.10.2.Photo Publisher
Photo Publisher is a professional photo retouching or image-editing package designed to enable
retouching and enhancing photos faster. It has powerful masking and retouching tools and more than
30 special effects and filters. It has an image browser, processor, scanner, printer calibration, a
stitching tool and over 50 ready to use textures and images.

2.11. EditingAudio

"Sound" is really a catch-all for many things like music (live recordings or digitally created), singing
voices, speaking voices, sound effects, and environmental sounds. These items can be used alone, or in
various combinations when creating anything from a podcast, to a full length movie.

Basic editing includes things like removing annoying "pops™ and "ticks". But even today's simplest
editors offer very sophisticated toolsets that include things like EQ, adding environmental effects,
octave shifting, slowing or speeding up the clips (without changing octaves!)

All audio editors can be used to record audio as well. So you can capture the sounds that you will later
edit.

2.11.1. Audacity
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If you do any type of creative work at all, this program should just be on your hard drive, period. It is an
open source (i.e., free and available on Mac, Windows and Linux)

2.11.2. Sony Sound Forge Pro

It's safe to say that Sony knows audio, and this program is a very capable and versatile professional tool
with an exhaustive list of features. It is designed for the professional, and has a price to match.
2.11.3. Adobe Audition

This is an excellent and very versatile package that allows extensive non-destructive editing, effects
work, video support, and various levels of multitrack support.

2.12. Text editing tools



A text editor (like notepad) is useful for making quick changes and quick typing of the text and it a
great tool to write out HTML code.

2.12.1 A word processor (like MS Word) has a plethora of options with which one can format the text and
can insert special symbols, colours, line spacing and a whole lot of other things that can't do with a
normal text editor.

2.12.2 Fontographer (sometimes abbreviated FOG), is a software application used to create digital fonts,

available for both Microsoft Windows and Apple Macintosh platforms. It was originally developed by Altsys

but is now owned by Font Lab Ltd.

2.12.3 Mapping Text:

Character mapping allows bullets, accented characters, and other curious characters that are part of the
extended character set on one platform to appear correctly when text is moved to the other platform.
2.13. Video editing tools
Video editing tools enable us to edit and assemble video clips captured from camera, animations and
other sources. The completed clip with added transition and visual effects could be played back. Adobe
Premiere and Media Shop Pro are two good examples of these tools.
2.13.1 Adobe Premiere

Adobe Premiere is a powerful tool for professional digital video editing. It is primarily used to produce
broadcast quality movies. It has excellent editing tools that enable the programmer to work with
complete flexibility. This software first digitizes the sound and video and then allows the programmer
to edit them to preserve picture quality. It can edit video and multimedia movies in AVI as well as
MPEG format. It can create titles and graphics and then add them to the multimedia project. This
software has applications in film editing and movie making.

2.13.2 Final Cut Pro
Final Cut Pro is a video editing program made by Apple. It is the editing software of choice for
multimedia journalists using Apple computers, and is comparable to Adobe's Premiere video editing
program.

2.13.2 Media Studio Pro

Media Studio Pro also gives the most complete set of advanced video editing tools. It can capture the
video from VCR, TV or camcorders. It is capable of capturing a batch of scenes. It brings all the
components of a multimedia project like video, sound, animation and titles together. One can add
effects and transitions and finally save the video in the desired format. It can retouch videos by painting
directly over any frame in a video sequence. It has an audio editor, which can remove background noise
and add another sound to your video.

2.13. Navigation and User Interface Designing

User interface (UI) design is the process of making interfaces in software or computerized devices with
a focus on looks or style. Designers aim to create designs users will find easy to use and pleasurable. Ul
design typically refers to graphical user interfaces but also includes others, such as voice-controlled
ones.

Designing Uls for User Delight

User interfaces are the access points where users interact with designs. Graphical user interfaces (GUIs) are
designs’ control panels and faces; voice-controlled interfaces involve oral-auditory interaction,

How to make Great Uls

To deliver impressive GUIs, remember — users are humans, with needs such as comfort and low cognitive loads.
Follow these guidelines:

1. Make elements such as buttons and other common elements perform predictably (including responses
such as pinch = zoom) so users can unconsciously use them everywhere. Form should follow function.
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Maintain high discoverability. Clearly label icons and include well-indicated affordances.
3. Keep interfaces simple and create an “invisible” feel. Every element must serve a purpose.
4. Respect the user’s eye and attention regarding layout; focus on hierarchy and readability:
o Alignment — minimize your number of alignment lines (think justified text); typically choose
edge (over center) alignment.
o Draw attention to key features using:
= Color, brightness and contrast. Avoid including colors or buttons excessively.
= Text via font sizes, bold type/weighting, italics, capitals and distance between letters.
Users should pick up meanings just by scanning.
5. Minimize the number of actions for performing tasks but focus on one chief function per page; guide
users by indicating preferred actions. Ease complex tasks by using progressive disclosure.
Put controls near objects users want to control.
Keep users informed vis-a-vis system responses/actions with feedback.
Consider defaults to reduce user burdens (e.g., pre-fill forms).
Use reusable design patterns to guide behavior regarding navigation and search functions.
0 Concentrate on maintaining brand consistency.
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Navigation

The term navigation is commonly used in multimedia to refer to the means by which the reader or user of a
work interacts with and moves about within a multimedia work, whether it be text, image, 3-D or moving image
based.

2.14. Use of various codes like bar code, QR code
2.14.1 Bar code

Anyone who buys stuff from stores must have seen barcodes; however, whether or not they realize it’s a
barcode they are looking at is a different matter altogether! A barcode is a visual representation of machine-
readable information about the product to which it’s attached. To put it down for a layman, a barcode is that
small box printed on the packaging of a product that has a small collection of black parallel lines of varying
widths.
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This isn’t just another box printed atop the cover of the product, it contains important information like the
manufacturer’s name, type of item, price and so on, which can only be read by dedicated barcode reader
machines. Since it only consists of data stored in horizontal direction, it is also dubbed as linear or 1D (1-
dimensional).



2.14.2 QR code

Quick Response code, often abbreviated as QR code, is much similar to a barcode. In fact, it’s a type of
barcode. Like barcode, it also contains machine-readable information concerning the item to which it is
attached. But, unlike a regular barcode, a QR code is two-dimensional, i.e. it contains information both in
vertical and horizontal directions.

QR codes contain a lot of information within them. From giant corporate organisations to next-door grocery
store, everyone can create their own QR code and attach them to their products.

There are certain QR code scanner apps that can be downloaded for free on smartphones. So the moment you
see a QR code, just scan it using the app on your phone (the app generally uses the primary camera of the
phone to scan the code) and the pre-determined action (like opening a website, sending a tweet, download an
app etc.) attached to the code will be triggered.



3. Using Image Processing Tools
3.1. Photo-shop workshop

Adobe Photoshop enables individuals to create and design digital images and illustrations for print and Web
publication. Photoshop developed from a small photo editing tool to an Industry leading software that
dictates the global graphic designing and multimedia industries.

3.2. Image editing tools
With the image editing and enhancement features of the software.

Using the Crop tool, you can trim edges, change the shape and size of a photo, and even straighten a crooked
shoreline or horizon.Adobe Photoshop editing tools are: Blur, Sharpen, Smudge, Dodge, Burn and Sponge

3.3. Specifying and Adjusting Colors
Adjusting image color and tone with adjustment layers
In the Adjustments panel, click the tool icon for the adjustment you want to make:

1. For tonality and color, click Levels or Curves.

2. For adjusting color, click Color Balance or Hue/Saturation.

3. For converting a color image to black and white, click Black & White.
4. In the Properties panel, adjust the adjustment layer tool settings.

3.4 using gradient tools

1. Choose the Gradient tool and click the Gradient Editor Button on the Options bar. ...

2. Click a stop and click the color swatch to the right of the word Color to open the Color Picker and
assign a different color to the stop.

3. Click anywhere below the gradient preview to add more color stops.

4.

3.5 (a)Adobe Photoshop — Selection Tools

Selection tools make life easy for photographers, Graphic designers and every professional that is associated
with multimedia. The precision of selection has been improved over years, and the detail we obtain is
fabulous.

3.5(b)Move Tool in Photoshop

The move tool in Adobe Photoshop can perform numerous functions such as move the content of a layer,
copy layers, directly move layers from one document to another, apply transforms, plus select and align
multiple layers.

3.6 Transforming Path Drawing and Editing Tools
Do one of the following:

1. To select a path component (including a shape in a shape layer), select the Path Selection tool , and
click anywhere inside the path component. ...

2. To select a path segment, select the Direct Selection tool , and click one of the segment's anchor
points, or drag a marquee over part of the segment.

3.7 using channels
Select and edit channels

1. To select a channel, click the channel name. Shift-click to select (or deselect) multiple channels.
2. To edit a channel, select it and then use a painting or editing tool to paint in the image. You can
paint on only one channel at a time.



3.8. Adobe Photoshop — Layers

With Layers palette, you can draw or design various elements of your document independently in layers and
stack them up as per the order of display. With this advantage, control over every single object is catered at
the click of a mouse. Mistakes happen, but the effects of the mistake are limited to the part of the canvas,
you can choose to work on the particular part and leave the rest of the canvas as it is. This benefit is lacking
in the traditional painting method. Artists are not allowed to relax at any part of the drawing or painting,
once their concentration is diverted and a stroke of painting goes wrong! They are bound to change the
whole canvas.

3.9 filters and actions
3.9.1 Filters

You can use filters to clean up or retouch your photos, apply special art effects that give your image the
appearance of a sketch or impressionistic painting, or create unique transformations using distortions and
lighting effects.

1. Do one of the following:

e To apply a filter to an entire layer, make sure the layer is active or selected.

e To apply a filter to an area of a layer, select that area.

o To apply a filter non-destructively so you can change your filter settings later, select the Smart
Obiject that contains the image content you want to filter.

2. Choose a filter from the submenus in the Filter menu.
If no dialog box appears, the filter effect is applied.

3. Ifadialog box or the Filter Gallery appears, enter values or select options, and then click OK.
3.9.2 Actions

Steps
Launch Photoshop and open an image. ...
e Click "Create New Action" in the Actions Panel. ...
e Choose your action settings. ...
e Click on "Record.”...
e Edit your image. ...
e Click on "Stop Recording" to finish. ...
e Test your action on another image. ...
e Perform an action on multiple images at once.



4. Multimedia Authoring Tools
5.

4.1 Multimedia Authoring Tools

Multimedia Authoring Tools are also known as Author ware. It is a program that helps the author
(user/programmer)writes hyper text (or) multimedia application.

4.2 Types of Authoring programmes
4.2.1. Card and page based tools
4.2.2. Icon based- event driven tools

4.2.3. Time based tools

4.2.1Card and page based tools:

This tool provides a simple and easily understandable metaphor for organizing multimedia elements. It
contains media objects such as buttons, text files and graphic objects. It provides facilities for linking
objects to pages (or) cards. The software required is Hyper card and Linked card tool box.

4.2.1.1 Advantages:

Easy to understand

Easy to use

Easy to link metaphorl=screenl=card1l= pagel

It consumes very less time for developing an application.

4.2.1.2Disadvantages:

e Few applications run only on one platform.
o Card and page tools are not powerful as unique stand alone.

4.2.2. lIcon based- event driven tools
Icons (or) object based tools are the simplest event driven authoring object. Its
provision of simple branching has the ability to go to another section of multimedia
production. Multimedia elements and interaction are organized in the flowchart. A
flow chart can be build by dragging appropriate icons from a library and then
dropping them in the required field finally adding multimedia elements to it. The
software required is Icon Author and Author ware.

4.2.2.1 Advantages:
e It has a clear structure [appropriately designed flow charts].
e Easy to edit and update the elements.

4.2.2.2 Disadvantages:

e Learning process is very difficult.
e Very expensive in nature.

4.2.3. Time based tools
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Time based tools are best suited for a message with a beginning and an end so that a message
can be passed within a stipulated time period. Few time based tools facilitate navigation and
interactive control. It has the branching technique so that different loops can be formed for
different multimedia applications and time period can be set for these individual applications.
The software required is Adobe’s Directors.

4.2.3.1 Advantages:

e These tools are good for creating animation.
e Branching, user control interactivity.

4.2.3.2 Disadvantages:

Steep learning curve for advance features.

e Music and sound files embedded in Flash movies increases the file size and increases
the download time.

e Very expensive.

Story boarding/scripting

A two-column script is an easy way to structure and plan for your digital story. Even if you
don't know exactly what images or sounds you will acquire, writing a script predicting what
you want your final digital story to look like is a great way to stay organized. Once you do
gather all your images and sounds, you can update your two-column script to reflect what you
actually have to work with.

Creating a live-action or animated film is a long and complex process, but - if all goes well - has a rewarding
outcome. Using Storyboard That to plan your next film gives you an easy way to keep your project organized
every step of the way!
Storyboarding has great potential for the filmmaking process. You can make plot drafts and character maps for
planning, and use the traditional shot-by-shot storyboarding method for the actual filming.

4.4 object oriented working in macromedia flash
Obiject-oriented programming (OOP) is a way of organizing the code in a program by grouping it into
objects. The term object in this sense means an individual element that includes information (data values)
and functionality. When you use an object-oriented approach to organizing a program you group particular
pieces of information together with common functionality or actions associated with that information. For
example, you could group music information like album title, track title, or artist name with functionality
such as “add track to playlist” or “play all songs by this artist”. These pieces are combined into a single
item, an object (for example, an “Album” or “MusicTrack”). Bundling values and functions together
provides several benefits. One key benefit is that you only needing to use a single variable rather than
multiple ones. In addition, it keeps related functionality together. Finally, combining information and
functionality allows you to structure programs in ways that more closely match the real world.

4.5

4.6

Exploring interface using selection of PEN tools

Flash has a Pen Tool. Some developers groused over the addition of this new feature, saying that the
original drawing set was fine and that this was only being added to attract new users who might be
more familiar with FreeHand or other drawing programs. Frankly, these people sounded like
members of a child’s club, comfortable in their tree fort, as they haul up the rope ladder.

Working with drawing and painting tools



There are a few key concepts to grasp about how Flash creates artwork. Shapes drawn in Flash consist of
strokes, fills, or both. Strokes are outlines, and fills are interiors. Even in shapes containing both, strokes and
fills are independent of each other. That allows you to set their attributes separately, and even to move them
independently to create unusual shapes.

The Paint Tools (Tools menu)

The GIMP Toolbox includes thirteen “paint tools”, all grouped together at the bottom (in the default
arrangement).

The Paint Tools (Tools Box)
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4.7  Applying colour viewing

Flash offers a lot of options for creating, saving, and working with colors and gradients. In addition,
the panels and workspace make it easy to choose and apply colors from virtually anywhere, or to
save color sets that you can share between multiple Flash documents and projects.

Getting set up

1 First you’ll want to make sure that the Color and Swatches panels are visible. Choose Window >
Color. By default, the Color and Swatches panels are already grouped together.
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The Swatches and Color panels are grouped together by default

2 Drag the panel group by its title bar over the Property Inspector and Library panel on the right-hand
side, releasing the mouse when you see a light blue line. The two panels should now appear docked
in the panel group above the Property Inspector and Library panel.

Solid color

Move the Color and Swatches panel group to the Properties and Libraries panel group

Manipulating time line
The position, size, and shape of the timeline can be manipulated to better suit your workflow, much like
any other Flash window or panel. On a dual monitor system, the timeline can be exiled to the second
monitor, together with all the panels leaving the stage clear and unencumbered for wild creativity.
Move the timeline by dragging it by the Timeline Title Bar, which is the bar at the top that says
timeline. If the timeline is docked, click anywhere in the gray area above the layer stack to undock the
timeline and reposition it.
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If undocked, resize the timeline by dragging on the lower right corner (PC), or the size box (Mac),
which is also in the right corner. If docked, drag the bar at the bottom of the timeline that separates the
layers from the application window, either up or down.
To resize the name and icon controls (either to accommodate longer names or to apportion more of the
timeline to frames), click and drag the bar that separates the name and icon controls from the frames
area.

Animating

Flash is the premier medium for Animation on the Internet, and even on other formats such as
Television. Creating a simple Flash Animation in Flash is actually fairly simple to accomplish, as
Flash provides a lot of useful Tools that simplify the entire process. If you've got an idea for a Flash
Animation or a Cartoon, you can probably have a rough sketch going in just a couple hours.

4.9.1 Understand the basics of frame-by-frame animation

"Traditional" method of animation, in that each frame has the same picture but slightly altered. When
the frames are played together, the images appear to move. This is the same basic technique used by
traditional hand-animators, and is more time-consuming than tweening.

By default, Flash will produce animations at 24 frames per second (FPS). That means one second of
animation will have 24 frames, but not every frame has to be different. You can adjust this if you'd
like, and many Flash animations use 12 FPS, but 24 will produce much "smoother"-looking
animation.

49.2 Tweening

4.10
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Tweening is great for a couple of reasons. Tweened animation is a huge time-saver because it
doesn’t require that you draw out your animation frame-by-frame. Instead, you establish endpoints
and make drawings for each of those end points. Then you let Flash interpolate, or tween, the
changes between them. Tweening also minimizes file size because you do not have to save the
contents for each frame in the animation.

Processing

Flash Programming Algorithms are a piece of software to erase or download applications to Flash
devices. A Pack with Device Support usually contains predefined Flash algorithms for programming
the devices that are supported by the DFP. A template for creating new algorithms are available in
the ARM:CMSIS Pack. The following section describes the process in more detail.

Guiding layers

Guide layers make it easy to keep the layout of your movie consistent, or to trace images, drawings,
or other materials from which you want to develop an item. When employed as Motion Guides, you
can use Guide layers to create the complex motion of a frame-by-frame animation with the ease of a
tweened animation. Guide layers are not exported with the rest of the movie they’re just guides. So
use them as much as you want.

4.11.1Using Guide layers for layout

Guide layers are great when you need a little help drawing in Flash. Use them as guides for your
layout, as aids for drawing a complex graphic, or for anything else that you might need. To
reemphasize, because Guide layers aren’t exported with the movie, they do not add to the file size of
the final.



4.11.2 Adding a Guide layer
here are the steps for adding a Guide layer:

1. Draw or import your guide art into a layer by itself. This can be anything from a hand-drawn
sketch of your layout to a full-blown prototype of your design.

2. Open the Layer Properties dialog for this layer by double-clicking the icon to the left of the
layer’s name.

3. Set the Layer Type to Guide, as shown in Figure below (using either the Layer Properties or the
Contextual Menu, which is accessed with a right-click/ Control+click on the Layer name), and
then press OK.

4. Use Control=>Test Movie to test the movie. Do you see the guide art in the movie? You
shouldn’t! Remember, because it’s a guide layer, it isn’t exported with the rest of the movie.

4.12  Importing and editing sound and video clips in flash

An audio gives additional effect to the flash file and often adds to the viewers interest. Audio files can
also be used as event sounds, button sounds, etc.

4.12.11mporting sound

Steps

10pen Adobe Flash (or Macromedia flash) and select ActionScript 2.0 or 3.0 as your version.

2Create a new layer.

3Then go to "file" menu on the top and select ->"import to library" from the drop down, browse to the
location on to the hard disk and select the audio file.

Once selected flash imports the file to the library, open library panel and the audio file will be
displayed as a waveform in the library window.

4 Drag the audio file from the library on to the stage, make sure the layer currently selected is the new
blank layer.

5Add a new keyframe to the layer after any number of frames. The audio can be clearly seen as a
waveform.

6Go to "control" menu from the top and select play from drop down. The play head moves forward
and the sound plays.

4.12.2 Editing Import Audio in Flash
1) Select the keyframe on which the sound is placed.
2) In the Property inspector, locate and click the Edit Sound Envelope button (the pencil icon to the
right of the Effect drop-down list) in the Sound section. ...
3) Move these sliders to edit the in and out points of the sound or to trim unnecessary silence.
4.12.3 Importing video clips

To import video in Flash, you should begin by selecting the Import Video option from the File >
Import menu in Flash 8. Upon doing this, you will see the Select Video screen, which allows you
to browse to a video clip. Once you've picked the clip you'd like to convert, you can proceed to the
next step, Deployment. Deployment is simply choosing the manner that you will include the video
into your flash movie



4.12.4 Editing video clips in Flash

The Editing the Video portion allows you to specify clips that you will edit by dragging markers to
the video timeline. Upon doing so you can rename the clips, whereupon they show up on the left
side in a field that allows you to select different ones and will eventually show up as individual
symbols in your Library.



1. Small Questions

Q1. Do as directed.

a) Define the term Optical Disk.

b) Define the use of Crop Tool.

c¢) Define Multimedia.

d) What is the use of touch screen?

e) Define Kiosks.

f) Define CD-ROM.

g) What do you mean by Quick Time Format?

h) Define rotating.

i) What do you mean by Transformation?

) Give two differences between MPEG-1 andMPEG-2?
k) What do you mean by multimediadevelopment functions?
1) What do you mean by Joystick?

m) List four file types used in Multimedia.

n) What do you mean by AVI Files?

0) Define RGB Mode.

p) Define transformation of an Image.

g) What is the importance of Selection tool inFlash?

r) What do you mean by Anchor Point?

2. Short Answer Type Questions

Q2. Attempt any six questions.
i) How would you convert text to vector?

ii) Explain the working of DVD.

iii) Explain the working of touch screen.

iv) What do you mean by Cropping? Explain.

v) What are the applications of multimedia inEducation?
vi) Explain various types of printers in brief.

vii) List the steps of delete a layer.

viii) What do you mean by Compression?Explain in brief?
iX) Write short note on Filters.

x) What is tweening? Give one example of Tweening.

xi) What are the major components of Director Interface?
xii) What is the difference between drawing and painting tools?

xiii) Give the limitations of laser printer.



xiv) What is hypertext? Write an example of converting a normal text to hypertext.

xv) What are the benefits of multimedia applications in science and technology?

3. Long Type Questions

Q.3 what is computer animation? Explain different types of Computer animation techniques.

Q.4 Explain the usage of OCR and digital camera in multimedia.

Q.5 Explain various Video File Formats.

Q.6 what do you mean by Multimedia? List various real life applications where the multimedia is being used.
Q.7 what is Flash? Write Step by step instructions for creating Flash File?



